FAQ regarding the SISSA Digital Library
Research products and data

IRIS SISSA Digital Library is the institutional repository of the research output produced in SISSA. The repository offers a unique platform for the archiving, the access and the long-term conservation of research output and it is interoperable with the Italian Ministry of University and Research (MIUR site) for the purposes of evaluation exercises of the research (e.g. VQR, ASN).

It makes available the SISSA research output as requested from the European Union protocol (H2020, FP7).
Index

Section A – Funding and Open Access

1. The European Commission and Open Access
2. How to implement Open Access requested by funding bodies
3. Which versions of the research output can be uploaded to the Institutional Repository?
4. Elsevier imposes rather long embargo periods (a delayed access from the date of publication) rather long: how can I meet the requirements of H2020?
5. Is access also open for the research output funded by Italian governmental bodies?

Section B – Research data

1. Research data: when is open data obligatory and in which way?
2. What is research data?
3. Why does research data need to be open access?
4. Does all the data need to be open access?
5. Which features does the data need to have?
6. Which procedures have to be followed?

Section C – IRIS Sissa Digital Library (Self-archiving procedure)

1. What is ORCID ID?
2. How is the output organized on my Desktop?
3. How can I manage my Profile?
4. How can I self-archive a research item by harvesting it with an identification code?
5. What is ANCE database?
6. Where can I retrieve my output research identifications on Scopus and Web of Science databases?
7. What are the necessary criteria for research to be classified as internationally relevant?
8. Why doesn’t my name appear among the co-authors despite being recognized by the system?
9. How can I check my output workflow status?
10. When is my output sent to the MIUR site?
11. How can I get the bibliography of my output from SISSA Digital Library?
12. Conclusions
**Please note:** we recommend consulting this guide frequently as it is being continuously updated.

You can help us improve the service by sending proposals and suggestions to the following address:

[mailto:sdl@sissa.it](mailto:sdl@sissa.it)

**Contacts:**

- Mr Lucio Lubiana +39 040 3787472
- Mrs Stefania Cantagalli +39 040 3787460
- Mrs Maria Pia Calandra +39 040 3787484

[mailto:sdl@sissa.it](mailto:sdl@sissa.it)
A1. The European Commission and Open Access

The European Commission requires the Open Access publication of research output funded by "H2020. The EU framework programme for research and innovation", in accordance with clause 29.2 of the Grant Agreement.

To comply with this clause, each beneficiary of EU funding has to assure the open access of all the "peer reviewed" publications which represent the funded projects' results.

For this purpose the European Community has provided both facilities and guidelines: OpenAire

PLEASE NOTE: failure to fulfill any obligation indicated in the Grant Agreement, including the dissemination of open access data, may cause the reduction in starting funding.

A2. How to implement Open Access requested by funding bodies

In order to meet the requirements of funding bodies, each researcher funded by the European Commission and/or other ones will have to make their publications open access within the time stated in the agreement.

Publishing open access on the publisher’s site is not enough: you also have to self-archive the permitted publisher’s version in an institutional or subject-based repository.

The two main ways of archiving open access are:

<table>
<thead>
<tr>
<th>Green Road – Self Archiving in an institutional repository</th>
<th>Gold Road – Open access on a journal</th>
</tr>
</thead>
<tbody>
<tr>
<td>Upload the permitted publisher’s version.</td>
<td>Publication in peer-reviewed open access journals with sharing of publication costs by researchers, institutions or funding bodies.</td>
</tr>
<tr>
<td>Generally the publisher allows the Author’s Accepted Manuscript version without the publisher’s layout and already submitted to the peer-review process (known also as postprint). The publisher can request an embargo period: the publication is available open access after a certain period.</td>
<td><strong>DOAJ</strong> is an online directory which indexes high-quality open access journals.</td>
</tr>
<tr>
<td>See SHERPA/ROMEO database for the publisher’ self-archiving policies.</td>
<td><strong>GOLD APC:</strong> publication in traditional commercial journals through the payment of a fee.</td>
</tr>
<tr>
<td>ELSEVIER sets different embargo periods depending on the journal you have published in.</td>
<td>See the SISSA procedure for the payment of the Article Processing Charge (APC).</td>
</tr>
<tr>
<td></td>
<td><strong>BEALLSLIST</strong> is a database which lists predatory publishers and their related journals.</td>
</tr>
</tbody>
</table>

You can find the funding bodies’ requirements for open access on SHERPA/JULIET database.
A3. Which document versions of the research output can be uploaded to the institutional repository?

Before self-archiving your output in the institutional repository, you must always check the SHERPA/ROMEO database which provides information related to the international publisher copyright policies for self-archiving.

In accordance with the different publisher policies, the author can upload:

- **The publisher's version**: if the publisher allows it.

  Articles are often published with licenses suitable for the re-use (e.g. Creative Commons licenses). The **CC BY** license (Attribution) and the **CC BY-SA** (Attribution-ShareAlike) are the least restrictive.

- **The postprint version**: the Author’s Accepted Manuscript after peer-review changes. It does not feature the publisher's own formatting and logo. ([postprint example](#))

- **The preprint version**: it’s the Author’s version before the submission for peer review.

**PLEASE NOTE**: most publishers require an embargo of 12 months (delayed open access) for the postprint version

If self-archiving is not allowed by the publisher or if the funding body requires an embargo period of less than 12 months, the author can:

- **Choose a publisher which allows open access of your postprint before the 12 month period.**
  Look for the publishers' self-archiving policies on the SHERPA/ROMEO database;

- **Use a contract addendum**: Sparc addendum and Science Commons SCAE are legal tools that modify the publisher’s agreement in order not to surrender all your rights such as self-archiving your work in an institutional repository.

- **H2020** proposes this contract [addendum model](#)

A4. Elsevier imposes rather long embargo periods (a delayed access from the date of publication) rather long: how can I meet the requirements of H2020?

Elsevier applies specific embargo periods to the respective journals.

See: [“Journal Specific Embargo Periods”](#)

You can then meet the open access requirement for H2020 in the following way:

**IMMEDIATE ACCESS**: archiving your “Preprint” (Submitted Manuscript) in arXiv, bioRxiv or RePec that are subject-based archives.

The preprint will then be updated with the “Accepted Manuscript” also called “Postprint” (the Author’s referred version without the publisher’s layout).
DELAYED ACCESS: archiving your Accepted manuscript (Postprint) in your Institutional Repository.

PLEASE NOTE: the “Accepted Manuscript” has to report:

- the link to the publication with the DOI;
- a CC BY-NC.ND license (Creative Common Attribution, no Commercial, no Derivates works). See how to do

In practice you have to add into the header/footer: © year. Licensed under the Creative Commons…[insert license details and URL]

A5. Is access also open for the research output funded by Italian governmental bodies?

Yes.

Decree Law No 91/2013, art. 4, comma 2, amended by the Law 112/2013 “Urgent provisions to protect the enhancement and the promotion of cultural and tourism assets and activities” provides that the public bodies responsible for the release of scientific research funds, adopt the necessary measures for the promotion of open access.

Open access for publications is achieved in the following ways:

a) open access publishing

b) archiving the Accepted Manuscript (without the publisher’s layout) both in an institutional repository and in subject-based repository within 18 months from the first publication for STM journals (Scientific Technical and Medical journals) and 24 months for Social Sciences and Humanities journals

B1. Research data: when is open data obligatory and in which way?

The European Commission, as H2020 funder, has provided directives (from 2012), that require open access not only of scientific publications, but also of research data (specifically regarding some research areas) as well as the possibility of voluntary adherence by disciplinary areas which are not involved.

The latest guidelines can be found in the following document:

“Guidelines on FAIR Data Management in H2020”

The data included in all publications must be open access: either technically (in a non-proprietary format) and legally (the right of re-use must be included).
B2. What is research data?

The term “Open Research Data” refers to data which supports research. It must not have access restrictions and it has to be accessible to anyone online. Data can be many different things depending on the goals for which it has been generated and utilized (observational data, experimental data, simulation data, processed data) and it can be in different formats: tables, documents, audio and video recordings, algorithms, software, etc.

B3. Why does it need to be open access?

Beyond social advantages (of progress and collaboration), as well as economic and administrative advantages (of transparency), there are some obligations imposed by the European Commission which stipulate that the provision of funds is conditional upon open access as made explicit in the article 29.3 of the Grant Agreement.

B4. Does all the data have to be open access?

Not all data needs to be open. Naturally the European Commission provides for the possibility to opt-out during any phase of the project (both before and after signing the Grant Agreement) if the following conditions are met:

- if the project does not produce or collect data;
- if it is necessary to protect some data in case of economic exploitation;
- for security reasons;
- to protect sensitive and confidential data;
- if making the data open poses a risk to reaching the primary objective of the project;
- other legitimate reasons to be described or justified.

It is also possible to make available only a subset of data.

Personal data is managed in compliance with EU Regulation 2016/679 “General Data Protection Regulation” (GDPR).

SISSA has developed a Regulation regarding the protection of personal data. (See the SISSA Regulation)

B5. Which features does the data need to have?

For the European Commission data must follow the FAIR principle and be:

- **Findable**: therefore searchable through unique identifiers and descriptive metadata.
- **Accessible**: it must be archived in order to be easily reused.
- **Interoperable**: it must be shared through standard protocols (OAI-PMH).
- **Reusable**: it must be displayed in a non-proprietary format and it must be released with licenses which permit re-use such as the following Creative Common Licenses: CC0 (Public Domain), CC BY (Attribution).
For further details about the FAIR principles as well as how to self-verify if you have adhered to these principles, we recommend visiting at the following sites:

**GO-FAIR**

**FAIR assessment tool**

**B.6 Which procedures have to be followed?**

1) **Drawing up a DMP (Data Management Plan)**

The Data Management Plan describes the activity related to the management and storage of data according to the specifications of the discipline to which the researcher belongs. It must be drawn up within 6 months of the project approval. The researcher shall also indicate how the FAIR principles are implemented.

The Data Management Plan should contain:

- an administrative section relating to the research project with information on the name of the project, the name of the project manager, the funding body, the affiliation;

- an indication of the names of the data creator and the data curator;

- a data description (what data is to be collected and in what format) and an indication of the aim to be achieved;

- indicate how to make your data searchable: this means the description of your data with standard metadata;

- highlight which data is open access describing the tools and software that provide it (possibly indicate which data is closed and the reasons (ethical, legal, contractual reasons);

- indicate how to make your data reusable through licenses suitable for text and data mining. You may always set an embargo period (a delay for open access);

- Indicate the repository in which data will be stored and preserved in the long term (where appropriate indicate the charges incurred);

- The DMP must be updated throughout the project.

A **TOOL for creating a DMP (DMPonline)** is available at the following link:

[http://www.dcc.ac.uk/resources/data-management-plans](http://www.dcc.ac.uk/resources/data-management-plans)

It has been provide by the European Commission through the Digital Curation Center.

2) **Where can I store data (possibly in a non proprietary format) at the end of the project life cycle?**

- In a subject based repository already being in use by the target community.
The Karlsruhe Institute of Technology provides the “Registry of Research Data Repositories”: 
http://re3data.org/

It is an Open Science tool that helps researchers find the proper repository for storing their data and where they can choose suitable licenses such as the CC0 or the CC BY licenses.

- In ZENODO: it is a multidisciplinary repository managed by CERN of Geneva. It also assigns a DOI to identify the dataset.

3) After storing your data in the proper repository, link the dataset (with DOI, handle..) to IRIS-SISSA Digital Library into the dedicated field: “Research data” so that the dataset will be linked to the publication/s. This field (in the Tab. 2 – Describe) is mandatory for the output financed by public funds:

![Image]

C1. What is ORCID ID?

The Open Researcher and Contributor ID (ORCID), whose adoption has been nationally initiated by ANVUR through the I.R.I.D.E project (Italian Research IDentifier for Evaluation), is a unique identifier which associates each researcher with his/her own publications.

To synchronize the LoginMiur profile with the IRIS-SISSA Digital Library profile you need to create an ORCID ID (if you do not yet have one) or associate a pre-existing one. This should only be carried out once.

Once logged into IRIS, a registration window related to ORCID ID will appear.

To start the procedure you need to click on the button “Create or associate your ORCID ID”. At this point you can:

- create a new identifier (for users without an ORCID ID) with the button “Create a new ORCID ID”.

In this case you need to fill in a form entering the request data;

- set a password and click on

- associate an existing identifier with the button “Associate your ORCID ID”.
Simply enter your own ORCID credentials and click on the button **Authorize**

In the next steps, authorizations are requested to combine the ORCID ID with the local IRIS system and the national LoginMiur system.

To complete the synchronization procedures just tick the permission box and proceed through the “Authorize” button as before.

At the end the system will redirect the user to IRIS which will inform on the success of the procedure returning a message that will communicate the generated ID.

For further information see [here](#)

C2. How is the output organized on my Desktop?

After the Login, you will be on the main page called “Products Desktop”

In your personal view you will find the following Tabs:

- **My submissions**: view all the products for which you are recognized as the responsible author for your data.
- **Items to be validated**: the Tab displays products identified by the system on which you can perform your self-identification. Use the “Actions” menu to confirm or reject the proposed match. (figura)
- **Identification to be approved**: the tab display the products which you have contributed data to and on which co-authors have carried out a self-recognition request. You have to confirm or reject their request.

**Customized view**

Fig. 1
The tabs displayed in your personal view are the following:

- **My submissions:** view all the products for which you are recognized as the responsible author for your data.

- **Items to be validated:** the Tab displays products identified by the system on which you can perform your self-identification. Use the "Actions" menu to confirm or reject the proposed match. (figura)

- **Identification to be approved:** the tab display the products which you have contributed data to and on which co-authors have carried out a self-recognition request. You have to confirm or reject their request.

  To confirm the data, click on the **Validate identification** button.

**View customisation**

**Show / hide columns**

You can add further data to display in your Desktop (e.g. “Year”)

It is possible to move columns, order data and apply filters.

Fig. 2
You can then save these changes to your **personal view** (both the order of the columns and the filters) by clicking on and give it a title.

**Fig. 3**

To upload previously saved views, select the corresponding option from the drop-down list.

**Fig. 4**
The column indicates the sending status of your publication to the MIUR site. They can be:

- **success**: The product has been properly sent to the teacher site (with all the recognized authors).
- **update**: The publication has not yet been sent.
- **error**: The publication has been refused by the teacher site; clicking on this button, you can see the reason.
- **N/A**: The publication is in DRAFT status (unfinished).

**Only products in “Definitive status” can be sent to the teacher site.**

- **unable to sync**: The synchronisation with the LoginMIUR website is not active for a given publication.

**Fig. 5**

**Possible actions**

The button under the column allows you to perform some actions to a specific publication:

- Delete
- Update now (LoginMIUR website)
- Display
- Update
- See public version
- Change owner
- See history
- Contact owner

**Fig. 6**
C3. How can I manage my “Profile”? 

Alternative names

If in his/her publications, a researcher also uses a name other than that one saved in his/her profile, it is necessary to refer to the “Alternative names”.

To do it enter in your “Profile” > “Personal Data” > “Alternative names”, then click on + (Add entry) to create alternative names. And then SAVE your personal data.
Your Main alternative name is your preferred one for the creation of citations inside the system.

The alternative name must be entered in the descriptive field in the following form: Last name, First name.

Fig. 9

**TAB: “External IDs “External services identifications”**

Enter in the TAB “External IDs” your Scopus, ORCID identification codes, then click “SAVE”.

Edit Profile

Fig. 10
C4. How can I self-archive a research item by harvesting it with an identification code?

We advise you import your product with the function “Search by identifier” as it reduces the margin of errors in compiling metadata and facilitates the migration of data to the LoginMIUR site.

Procedure

Step 1: Log in to SISSA Digital Library with your SISSA username and password

![Fig. 11](image1)

Step 2: Access the repository in 1. “Personal view”, then 2. Open the menu (identified by a grid in the top bar)

![Fig. 12](image2)
Step 3: A side bar is displayed in which you can select 1. **Products > MyDSpace**, then 2. Click on **New Item**

1. Search by “identifier”: 2. Enter your DOI, Scopus, ORCHID ID or Pubmed code..., then 3. “Search”

Once you have found your publication, you have to import the metadata and select the publication type: 1. Import, 2. Select the publication type, 3. Import selected record.
Fill in the various TABS: Describe, Upload (file upload), Verify, License, Complete

1 – Describe:

Fig. 16
2 – Describe:

Using the **Submission by the “Identifier”** feature, many bibliographic data will automatically populate the record.

**We recommend you verify or enter (if not yet present), the following bibliographic data:**

<table>
<thead>
<tr>
<th>Title</th>
<th>Title of the product</th>
<th>Required</th>
</tr>
</thead>
<tbody>
<tr>
<td>Year of publication</td>
<td></td>
<td>Required</td>
</tr>
<tr>
<td>Year of publication online</td>
<td></td>
<td>Recommended</td>
</tr>
<tr>
<td>Language</td>
<td></td>
<td>Recommended</td>
</tr>
<tr>
<td>Journal, Series</td>
<td>In IRIS, journals are hosted by ANCE, the ministerial database managed by CINECA. If you use the <strong>Enter manually</strong> feature, click <strong>HERE</strong></td>
<td>Required</td>
</tr>
<tr>
<td>Web of Science code</td>
<td>Useful for assessment. <a href="#">Where do I find it?</a></td>
<td>Required</td>
</tr>
<tr>
<td>Volume number, issue, pages</td>
<td></td>
<td>Recommended</td>
</tr>
<tr>
<td>DOI code</td>
<td></td>
<td>Required</td>
</tr>
<tr>
<td>PubMed ID</td>
<td></td>
<td>Recommended</td>
</tr>
<tr>
<td>Scopus code</td>
<td>Useful for assessment. <a href="#">Where do I find it?</a></td>
<td>Required</td>
</tr>
<tr>
<td>URL</td>
<td>Repeatable field. You can add links to external repositories where a version of the products is archived (e.g. ArXiv, PubMed)</td>
<td>Recommended</td>
</tr>
<tr>
<td>Research data</td>
<td>Repeatable field. You can add a link to the repository where your research data is archived</td>
<td>Required for H2020</td>
</tr>
<tr>
<td>Referee</td>
<td></td>
<td>Recommended</td>
</tr>
<tr>
<td>Abstract</td>
<td></td>
<td>Recommended</td>
</tr>
<tr>
<td>Keywords</td>
<td></td>
<td>Recommended</td>
</tr>
<tr>
<td>Other information</td>
<td>Optional</td>
<td></td>
</tr>
<tr>
<td>Relevance</td>
<td>National/International. <a href="#">See criteria</a></td>
<td>Recommended</td>
</tr>
<tr>
<td>Funding program</td>
<td>To be filled if your project is funded by a FP7 – H2020 programme</td>
<td>Required</td>
</tr>
<tr>
<td>Project identifier</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

---

Fig. 17
3 – Describe

Type or paste in the box below the authors' names in one of the following formats: "surname, name;" or "surname, name," or "surname, n.;" or "surname, n.," or "surname name,." Then, click on the "Run the authors string" button. The system will process the typed string and show the authors as follows:

- **green** if recognized as SISSA's author;
- **gray** if external author;
- **orange**, if you have to disambiguate the recognition.

By clicking on the author's name it is possible: to disregard an internal author (if green); to disambiguate the author's name (if orange). It will also automatically calculate the number of authors and it will show the table of the identified authors (internal and external) with the possibility of add more information.

**PLEASE NOTE:** See the rules of SISSA authors for the IRIS SISSA Digital Library
In order to comply with Art.4 of SISSA’s Regulation on Open Access: “The SISSA shall endeavour to render all products archived in the SISSA Digital Library in open access format, consistent with the provisions of copyright law, contracts entered into with publishers and funding bodies”, start the archiving process of a “Post-print” version, or in the case of a “Pre-print”, with its “Corrigenda”.
Select your policy:

- Open Access
- Embargo
- Archive admin only (closed access)

If you have selected the "embargo" option, a calendar will appear:
Set the date from which the file will be open access

Then conclude your submission verifying your submission and granting your license in order to reproduce, translate and distribute your submission worldwide:
C5. What is ANCE database?

ANCE is a ministerial database managed by Cineca where national journals and series are indexed. In IRIS, to enter the details of the journal in which an article is published, or those of the series a monograph is part of, the user has to click on the ANCE button and search for the relevant journal or series.

The search can be performed by title, ISSN or ANCE code.

If the title of the journal is not present, the author can request it be included in the ANCE catalogue with the option “Enter manually”. In this case, the self-archiving of the new product will stay in “draft” mode until Cineca recognises the journal and sends the corresponding code.

![Search journal in ANCE catalogue](image)

Fig. 24
C6. Where can I retrieve my output research identification on Scopus and Web of Science databases?

**Scopus**

To find the identification code of your publication in Scopus, log in to [http://www.scopus.com/home.url](http://www.scopus.com/home.url) and search for your article.

Once you have found your contribution, pay attention to the URL:

![Scopus document details](image.png)

The identification code is found within the URL, between ?eid= and &origin= as shown below:

https://www.scopus.com/record/display.uri?eid=2-s2.0-0030508174&origin=resultslist&
Web of Science

To find the identification code of your publication in Web of Science, log in to http://apps.webofknowledge.com/ and search for your contribution. Click on the title and scroll the information on the page down to:

See more data fields > Document Information. In this section you can find the Accession number, i.e. the ISI identification code, identified by the acronym WOS which makes it easily recognisable: 000…………..

Fig. 26

C7. What are the necessary criteria for research to be classified as internationally relevant?

International relevance is generally assigned to a research product that meets at least one of the following verifiable indicators:

- the product is the result of an explicit cooperation with researchers and research groups working with institutions from foreign countries (e.g. within international projects);
- that product has been, or can also be disseminated within the scientific community in other countries;
- the publication has been submitted to an international scientific committee or the board and/or editorial team includes foreign scholars.
C8. Why doesn’t my name appear among the co-authors despite being recognized by the system?

It is necessary that the Data owner must validate your recognition by accessing:

“Identification to be approved” Tab.

To speed up the process, you can directly contact the data owner, requesting to perform this action.

Fig. 27

Please note: If the person responsible for the data does not validate the identification, the author’s name will not be added to the record and the information will not be transferred to the LoginMIUR website.
C9. How can I check my output workflows status?

The status of a product registration on IRIS can be as follows:

- **In validation**: when the author completed the submission, but the registration is yet to be verified and approved by the Library.
- **Re-opened**: when, following validation, the author accesses the tab using the **Re-open** button.
- **Validated**: the registration has been validated by the Library.
- **Draft**: when the author responsible for the data has not yet completed the submission.

Fig. 28
You can make changes to your record by using the “**Re-open**” button at any time, even after validation is complete. Then you have to “complete the submission” again.

C10. **When is my output sent to the MIUR site?**

The transfer is performed daily by incremental batch, which means that only modified products are synchronised. Metadata is synchronised first, followed by full-texts.

A new synchronisation of products in “Warning” status is attempted every week.

By default, the product's authors (personal view), administrators (full view) and the person responsible for the data can force the synchronisation.

**NB:** Only products that are not in “Draft” status (Definitive, In validation, Validated) are transferred to LoginMIUR

The **MIUR** column of the **Products Desktop** displays the **status** of the registration compared to the submission of the publication to the LoginMIUR website.
**C11. How can I get the bibliography of my output from SISSA Digital Library?**

You can export your bibliography by using the **Export** button on your **Products Desktop**. Different export formats are available.

IRIS allows you to export the list of your publications in citation format. By integrating the use of IRIS with two of the most popular tools - **Zotero** and **Mendeley** - you can choose your preferred citation style. The first is a free tool and the latter is the free version of the commercial product Elsevier.

This guide assumes that these tools are already installed on your PC. For further details on installation, go to the following download pages:

- [https://www.zotero.org/download/](https://www.zotero.org/download/)
- [https://www.mendeley.com/downloads](https://www.mendeley.com/downloads)

Through the “**Export**” feature, available both within the **Products Desktop** and in the search results section of the IRIS SISSA Digital Library, you can generate a bibliographic file with the list of publications for which you want to create a citation format. For example, to get a list of your publications, you have to access IRIS in “**Personal view**”, then go to **Products > Products Desktop**. Once you have obtained your list, click on the **Export** button, then choose your preferred format. In this guide the **BibTeX** format will be used.

---

Fig. 30
If, instead of your products, you want a citation-style list of a group of products, you can use the Advanced Search form.

Just click on Advanced Search. Using the filters (e.g. time range), you can generate the desired product list, and if you click Search, then Export, you get the bibliographic file of your products.
Generating a citation file with Zotero

Open Zotero, then go to **File > Import** and choose the IRIS-generated file.

![Zotero interface](image)

**Fig. 32**

This action will make the products exported from IRIS available.
Now, you have to **choose the products you want**, then **click on the right mouse button** and select “**Create Bibliography from Item**”.
In the next form, select your preferred citation style then click OK to generate an RTF file containing the desired bibliography.

**Choosing the bibliography format**
If you want to change the format of your bibliography, go to Edit > Preferences, then to the Export tab. Now you can change format by choosing a new one from the Default Format drop-down menu.

![Zotero Preferences](image)

**Fig. 35**

To find out more on the use of Zotero, go to https://www.zotero.org/support/

**Generating a citation file with Mendeley**

Open Mendeley Desktop, then go to File > Import and choose the IRIS-generated file.
This action will make the products exported from IRIS available.
Now, select the products you want, then click on the right mouse button and select Copy As > Formatted Citation.
Now you just have to open a text editor and paste the generated bibliographic citation. To find out more on the use of this tool, go to


C12. Conclusions
Open Science
For any queries, please contact:

sdl@sissa.it

Visit also the support guide of OpenAire

https://www.openaire.eu/guides